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Overview

Hacking Kiosks:

What is an Internet KioskWhat is an Internet Kiosk.

Kiosk Software Security Model.

Vulnerabilities in Kiosk Software.

Vulnerabilities in the Kiosk Security Model.

Hack any Windows Kiosk in less than 120 seconds!y

Defcon 16 Exclusive: Tool ReleaseDefcon 16 Exclusive: Tool Release.

Live Demo’s: Hacking (Two) Commercial Internet Kiosks.



What Is An Internet Kiosk

Last Year I Was Sitting in an Airport….

8 hour stop-over in Hong Kong8 hour stop-over in Hong Kong.

Queue of people waiting to use a hub of Internet Kiosks.

“Damn those kiosks sure are popular ”“Damn, those kiosks sure are popular…”

“I wonder if I could hack it?. Lemon party the airport.?”

Kiosks are popular, but rarely appear in security publications.

Popularity + Poor Security Visibility = Good Attack Targetp y y y g

Personal Objective:

Find every possible method of hacking an Internet Kiosk.

Become the King of Internet Kiosk Hacking!



What Is An Internet Kiosk

Kiosks are everywhere

Airports Train stations Libraries DVD Rental Stores CorporateAirports, Train stations, Libraries, DVD Rental Stores, Corporate 
Building Lobbies, Convenience Stores, Post Office, Café’s, 
Hospitals, Motels, Hotels, Universities.

All over the strip, even in this hotel!

Cheap technology has made Internet Kiosks very common.



What Is An Internet Kiosk

Initial Observations of Kiosks

Hardware.

Ki k ft b ilt i t h h d h llKiosks often built in tough hard-shell cases.

Fibreglass or wooden shell.

Lack of physical access to the computer case.

Input devices hidden (Floppy/DVD/USB/FireWire)

Kiosk bolted to the ground (padlocked).

General public are not trusted.

Kiosk is designed to prevent theft or malicious use.



What Is An Internet Kiosk

Software.

Majority of Kiosks run commercial Kiosk software on WindowsMajority of Kiosks run commercial Kiosk software on Windows.

Linux/BSD Kiosks exist, Windows more popular.

44 commercial Windows Kiosk products on the market.

Marketed as : “Turn that old PC into instant revenue!”

Buy $59.99 Shareware -> Install -> Instant Kiosk!

k f ll k dKiosk Software Essentially Skins Windows:

Kiosk browser implements standard Internet Explorer libraries.

WINHTTP.DLL/MSINET.OCX

Windows drastically skinned to look like a Kiosk.

Still ‘feels’ like Windows.



What Is An Internet Kiosk

“Kiosk Software Is The Best Attack Target.”

Hardware hacking too obvious/intrusive for public locationsHardware hacking too obvious/intrusive for public locations.

“I Need to Walk up to Any Internet Kiosk and Pop Shell, Quickly.”

Explorer.exe, cmd.exe, command.com.

Time limited, 5 minutes or less.

16 Months of Kiosk Software Penetration Testing.

Vi t li d th t t t l Wi d Ki k d tVirtualized the top ten most popular Windows Kiosk products.

Detailed and compared the security model of each Kiosk product.

Researched new methods of compromising internet Kiosks.

Developed Kiosk Attack Methodology.

Startling results: 100% success rate!



Kiosk Security ModelKiosk Security Model



Kiosk Security Modely

Kiosk Software Implement Security by Two Approaches.

Reduce Available Host Functionality.

Disallow native OS functionality that can be used maliciously.

“Command Prompt has been Disabled”

Implemented through native ACL’s.

Jail Users Into a ‘Secure Kiosk Browser’ Application.pp

Users are stuck inside a Kiosk browser.

Kiosk browser ran in full screen, no ability to close, minimize.Kiosk browser ran in full screen, no ability to close, minimize.

Start Bar/Tray Menu removed or hidden.

Only thing you can do is browse the webOnly thing you can do is browse the web.



Kiosk Security Modely

Example #1: Site Kiosk.

Looks similar to WindowsLooks similar to Windows.

Custom Tray Menu/Task Bar.

O l ti ‘N Wi d ’Only one option, ‘New Window’

Real Windows ‘Start’ bar is hidden from view.

Trapped inside the Kiosk browser.



Kiosk Security Modely

Example #2: NetStop Kiosk

Custom task bar, no buttons at all.

Kiosk application ran as a full screen desktop.

No ability to close  the browser.

Only permits internet browsing.

Used here at the Riviera hotel



Kiosk Security Modely

Kiosk Browsers Proactively Monitor Your Activity.

Kiosks contain numerous blacklists of prohibited activity.

Try to do something sneaky, the Kiosk will stop you.

Try to Browse C:\ with the Kiosk browser:Try to Browse C:\ with the Kiosk browser:

Monitor in focus Modal DialogsMonitor in-focus Modal Dialogs.

Block dialogs by Window Title or Window Class.

“S Fil A ” “O With” “C fi Fil D l t ” “P i t”“Save File As”, “Open With”, “Confirm File Delete”, “Print”.

Kiosk sends WM_CLOSE Message to the blacklisted dialogs.



Kiosk Security Modely

API Hooking.

Hook native OS API calls which can be used maliciouslyHook native OS API calls which can be used maliciously.

KillProcess(), GetCommandLineW(), AllocConsole()

“Unauthorized Functionality Detected Process Killed”Unauthorized Functionality Detected, Process Killed .

Kiosk Browser ran in ‘High Security Zone’

File downloads disabled.

Browser scripting, pop-ups, ActiveX, all disabled.

Watchdog Timer.

E X i h Ki k ill ll iEvery X minutes the Kiosk will enumerate all active processes.

Terminate any unauthorized processes.



Kiosk Security Modely

Custom Keyboard Driver.

Disable Windows shortcut key combinationsDisable Windows shortcut key combinations.
CTRL-SHIFT-ESC (Task Mgr)

ALT-TAB (Switch Task)

CTRL-ALT-DELETE (Task Mgr)

CTRL-ESC (Start Menu)

Alt-F4 (Close Application)

Modifier keys unmapped.

CTRL, Tab, ALT, ‘Start’, Function, F1-F12.

Alt F4 (Close Application)

CTRL, Tab, ALT, Start , Function, F1 F12.

Custom Keyboard with missing modifier keys!

Custom MouseCustom Mouse.

No right click button.

All M th d f d i f ti lit !All Methods of reducing functionality!



HackingHacking

Ki k S ftKiosk Software



Hacking Kiosk Softwareg

Kiosk Security Model is Based on Reducing Functionality.

Limit functionality which can be used to escape the Kiosk browserLimit functionality which can be used to escape the Kiosk browser.

Exploiting A Kiosk Requires Invoking Functionality.

Cause applications/functionality to spawn, popup on screen.

Use the invoked functionality to escape the Kiosk jail.

Spawn a command prompt, get back to Windows.

Kiosks Implement BlacklistsKiosks Implement Blacklists.

Blacklists (by nature) are never 100%.

W l d h d f i h f j ilWe only need one method of escaping the software jail.

Kiosks are very hack-able.



Hacking Kiosk Softwareg

What Are The Available Kiosk Input Vectors?

#1 - Physical Input:

Interacting with the Kiosk GUI.

Using the keyboard or mouse.

Clicking on buttons, graphics, menu’s.

Type values into text input fields.

#2 Remote Input:#2 - Remote Input:

Browsing a website from a Kiosk terminal.



Hacking Kiosk Softwareg

What Do We Need To Do?

#1 - Escape The Kiosk Graphical Jail.

Minimize or close the Kiosk browser application.

Pop a command shell.

Kill the Kiosk browser process (taskkill /IM KioskBrowser.exe)

Re-Enable the hidden (real) Windows Start bar.

Get “Back to Windows.”

#2 - Download Additional Binaries to The Kiosk.o o d dd o s o os

Port scanner, Metasploit, rootkit, trojan, keylogger.



Hacking Kiosk Softwareg

You Find a Kiosk in Your Local Mall.

“$1 for 1 hour of internet usage”$1 for 1 hour of internet usage

Insert a dollar.

You Find You are Trapped Inside a Kiosk Browser.

Right mouse button has been disabled.

Custom keyboard with certain keys removed.

Feels like a Windows OS , but has a custom design/layout.

‘Start’ bar is labelled ‘Super-Kiosk Start’.

Only one visible button to ‘Start Browsing’

Start BrowsingStart Browsing…



Hacking Kiosk Softwareg

Browse The Local File System Using The Kiosk Browser.

Local Windows users are capable of browsing the file-systemLocal Windows users are capable of browsing the file system.

Kiosk software must explicitly block local browsing attempts.

Windows is designed for idiots.

Caters for mistypes/fat-fingers.yp / g

C:\windows\ maybe blocked.
File:/C:/windows File:/C:\windows\ File:/C:\windows/ File:/C:/windows

File://C:/windows File://C:\windows/ file://C:\windows C:/windows

C:\windows\ C:\windows C:/windows/ C:/windows\

%WINDIR% %TMP% %TEMP% %SYSTEMDRIVE%

Bl kli t t t f ili b t

%WINDIR% %TMP% %TEMP% %SYSTEMDRIVE%

%SYSTEMROOT% %APPDATA% %HOMEDRIVE% %HOMESHARE%

Blacklists start failing about now.



Hacking Kiosk Softwareg

Using Common Dialogs To Hack Kiosks.

Windows contains ‘Common Dialogs’ librariesWindows contains Common Dialogs  libraries.

Saving a file, opening a file, selecting font, choosing a colour.

COMDLG32 DLL (Common Windows Dialogs Library)COMDLG32.DLL (Common Windows Dialogs Library).

COMDLG32.DLL Implements Common Windows Controls.

From COMCTL32.DLL.

File/Open, File/Save Dialog’s Contain ‘File View’ Controls.

File view control provides full Explorer functionality.

Same control that Windows Explorer uses.

File-Open Dialog = Explorer

Can be used to launch processes.



Hacking Kiosk Softwareg

Systematically Click Every Button, Graphic, Icon In The Kiosk

Can we invoke a File - Open Dialog? “Attach File”Can we invoke a File Open Dialog? Attach File

Browse the file system

Right Click cmd exe: Open / Run AsRight Click cmd.exe: Open / Run As

Spawn cmd.exe



Hacking Kiosk Softwareg

Internet Explorer ‘Image Toolbar’.

Toolbar hovers top-left of a large image when clickedToolbar hovers top-left of a large image when clicked.

Each icon of this toolbar can invoke a Common Dialog.

Fil /SFile/Save.

File/Print.

File/Mailto.

Open “My Pictures” in Explorer.

Toolbar is present if the Kiosk uses Internet Explorer libraries.

Click a large image on screen

Spawn a Common Dialog, spawn Explorer.



Hacking Kiosk Softwareg

Using the Keyboard.

Keyboard shortcuts can be used to access the host OSKeyboard shortcuts can be used to access the host OS.

Check if a custom keyboard driver present?

A difi k bl d?Are modifier keys enabled?

Keyboard Shortcuts Which Produce Common Dialogs.

CTRL-B, CTRL-I  (Favourites)

CTRL-H  (History)

CTRL L CTL 0 (File/Open Dialog)CTRL-L, CTL-0 – (File/Open Dialog)

CTRL-P – (Print Dialog)

CTRL-S – (Save As)

Kiosk Specific ‘Administrative’ shortcuts.

All Kiosk products contain a hidden Administrative menu.

( )

p

Mash the keyboard, CTRL-ALT-F8? CTRL-ESC-F9?



Hacking Kiosk Softwareg

Browser Security Zones

Browser security model incorporates multiple security zones:Browser security model incorporates multiple security zones:

Restricted Sites

Internet Zone

Intranet ZoneIntranet Zone

Trusted Sites

Each security zone adheres to a unique security policy.

Internet zone has less ability to interact with the Kiosk.

Locked Down by the Kiosk browser.y

Trusted Sites, Intranet Zone have more access.



Hacking Kiosk Softwareg

Local Users Can Access All Available Security Zones.

URL’s must be typed into the URL entry barURL s must be typed into the URL entry bar.

Security Zone Escalation: about: pluggable-protocol handler.

About handler belongs to the ‘Trusted Sites’ security zone.

Suffers from a Cross Site Scripting vulnerability.

Local user can render arbitrary content within a trusted zone.

l l f dSpawn a File Open Common Dialog from a trusted security zone.

about:<input%20type=file>

about:<a%20href=C:\windows\>Click-Here</a>

Internet Zone may be locked down, Trusted Sites never are.Internet Zone may be locked down, Trusted Sites never are.



Hacking Kiosk Softwareg

Shell Protocol Handler.

Shell handler provides access to Windows web foldersShell handler provides access to Windows web folders.

Type Into the URI Bar:Type Into the URI Bar:

Shell:Profile

Sh ll P FilShell:ProgramFiles

Shell:System

Shell:ControlPanelFolder

Shell:Windows

Each URL will spawn explorer.exe and browse the webfolder.

Is the shell: handler blocked by the Kiosk?



Hacking Kiosk Softwareg

How About This:

shell:::{21EC2020 3AEA 1069 A2DD 08002B30309D}shell:::{21EC2020-3AEA-1069-A2DD-08002B30309D}

Web folder invoking the Windows Control Panel by CLASSID.

W k f WININET DLL/MSINET OCXWorks from WININET.DLL/MSINET.OCX

Bypass ACL’s that may exist on control.exe (Control Panel)



Hacking Kiosk Softwareg

The Downside to Physical Input Vectors.

Kiosk software is designed to not trust the guy on the keyboardKiosk software is designed to not trust the guy on the keyboard.

Kiosk User = Most Obvious Security Threat.

My research concluded that physical inputs are not very successfulMy research concluded that physical inputs are not very successful.

40-50% chance of popping shell.

M t f th t h i l d bli h d i i lMost of these techniques already published, unoriginal.

Then I Made a Subtle Discovery…

Remote websites not factored highly into the Kiosk security model.

Websites are often trusted MORE than a local Kiosk user!

Kiosks rely on the default browser security model!

Not designed for Kiosks.



Hacking Kiosk Softwareg

Available Remote Input Vectors:

Content visited from a Kiosk terminalContent visited from a Kiosk terminal.

Hosted on a remote website.

Browser Scripting 
Languages

Java Applets ActiveX ClickOnce (.NET)

Protocol Handlers File Type Flash Directoryp
Handlers

Acrobat Real Media QuickTime Windows Media 
PlayerPlayer

More input vectors than physical attacks!



Hacking Kiosk Softwareg

“I Need a Kiosk Hacking Website.”

An online tool you can visit from an Internet KioskAn online tool you can visit from an Internet Kiosk.

Provides content to escape a Kiosk jail.

iKAT – Interactive Kiosk Attack Tool – Official Release

First of its kind! New method of hacking Internet Kiosks!g

Fast!  iKAT can pop shell in less than 120 seconds .

95-100% success rate!!95 100% success rate!!

Officially Launched @ Defcon 16: http://ikat.ha.cked.net



Hacking Kiosk Softwareg

What Can iKAT Do?

Kiosk Reconnaissance : Detect Installed ApplicationsKiosk Reconnaissance : Detect Installed Applications

JavaScript & res:// (resource) protocol handler.

Extract bitmap resources from PE executablesExtract bitmap resources from PE executables.

Verify bitmap presence and detect installed applications.

Detects the most common commercial Kiosk platforms.

Enumerates locally installed applications.y pp



Hacking Kiosk Softwareg

Display Local Browser Variables.

Determine underlying Kiosk browser technologyDetermine underlying Kiosk browser technology.

MSINET.OCX, WINHTTP.DLL display Internet Explorer appVersion

Detect the presence of NET CLRDetect the presence of .NET CLR.

Display Remote Server Variables

Discover remote IP address of the Kiosk terminal.



Hacking Kiosk Softwareg

All Common Browser Dialogs In One Place

File Open, Save As, Print, Print Preview:

Click down the list and determine what dialogs are blocked.

Use the File View control within the dialogs.



Hacking Kiosk Softwareg

Use Flash To Invoke Common Dialogs.

Adobe Flash is the most widely used browser plug-inAdobe Flash is the most widely used browser plug in.

ActionScript 3 can invoke three unique File Open dialogs.

‘Select File For Upload’Select File For Upload

‘Select File(s) For Upload’

‘S l t l ti f D l d b ik t h k d t’‘Select location for Download by ikat.ha.cked.net’

Flash Common Dialogs have Unique Dialog Titles

Not standard “Choose File”

Bypass dialog Window title blacklists.ypa d a og do b a

Still contain the File View control.



Hacking Kiosk Softwareg

Spawning Applications On The Kiosk.

Can we cause an applications/processes to launch on the KioskCan we cause an applications/processes to launch on the Kiosk.

Perhaps the spawned application contains a common dialog?

Application provides additional access to the KioskApplication provides additional access to the Kiosk.

iKAT Invokes Default Windows URI Handlers.

C llt // G h // HCP // T l t // TN3270 // Rl i //Callto://, Gopher://, HCP://, Telnet://, TN3270://, Rlogin://, 
LDAP://, News://, Mailto://

<A HREF=Mailto://aaa> Mailto </a><A HREF=Mailto://aaa> Mailto </a>

Outlook express spawns.

3rd party URI Handlers

MMS://, SKYPE://, SIP://, Play://, Steam://, Quicktime://



Hacking Kiosk Softwareg

Example: HCP://: Help And Support Center

<a href=HCP://dummy> Click-me </a><a href HCP://dummy> Click me </a>

Search HCP for what you want to launch.

“Using Command Prompt” provides link to spawn cmd exeUsing Command Prompt  provides link to spawn cmd.exe

Left Click Only! (No right click button required)



Hacking Kiosk Softwareg

iKAT Provides Links to over 100 URI handlers.

Click click click down the listClick, click, click down the list.

Determine which handlers are covered by the Kiosk blacklist.

Use invoked handler application to escape the KioskUse invoked handler application to escape the Kiosk.

iKAT C t i L l Z H dliKAT Contains Local Zone Handlers

about:, res:, shell:

Lists of URL’s to type in.

Remembering ClassID’s is hard.



Hacking Kiosk Softwareg

Invoke Applications Using File Type Handlers.

Click on test myfile Windows will spawn the ‘myfile’ handlerClick on test.myfile, Windows will spawn the myfile  handler.

Internet Explorer supports prompt-less handler execution.

Example: Click test wmv Windows Media Player SpawnsExample: Click test.wmv, Windows Media Player Spawns.

No Prompt “Are you sure you want to…”.

Kiosk blacklists monitor all in focus dialogs for warning prompts.

iKAT uses DHTML/JavaScript to invoke 108 unique file handlers.



Hacking Kiosk Softwareg

iKAT & Windows Media Files.

WMPlayer will silently launch for multiple file typesWMPlayer will silently launch for multiple file types.

Windows Media Playlist Files (.ASX)

S t ‘W b E h d C t t’Supports ‘Web Enhanced Content’.

Turns Windows Media Player into a web browser!y

Provides a browser without the typical Kiosk security controls.



Hacking Kiosk Softwareg

iKAT & Office Documents.

If an Office file viewer is installed on the Kiosk we winIf an Office file viewer is installed on the Kiosk, we win.

Embed a copy of cmd.exe within an office document.

Supported by DOC DOCX XLS XLSB XLSM XLSXSupported by .DOC,.DOCX,.XLS,.XLSB,.XLSM,XLSX

Using Word to Execute Our Embedded CMD.EXE.

‘ k ’ d l d d b k‘Open Package Contents’ dialog not detected by any Kiosk.

iKAT will spawn the most ‘useful’ file possible.



Hacking Kiosk Softwareg

iKAT & Java Applets:

Signed Java applets can execute local processesSigned Java applets can execute local processes.

Detect if JRE is installed (iKAT Kiosk Reconnaissance Trick).

Does the Kiosk detect the Java security warning prompt?Does the Kiosk detect the Java security warning prompt?

“Warning – Security”

iKAT C i Si d Ki k S ifi J A liKAT Contains Signed Kiosk Specific Java Applets.

Signed applets to spawn command shells

Includes Jython by GNUCITIZEN



Hacking Kiosk Softwareg

Install a Malicious ActiveX

Safe for scripting ActiveX’s can be used to compromise a KioskSafe for scripting ActiveX s can be used to compromise a Kiosk.

Unsafe method: object.execute(‘cmd.exe’);

Can we install a malicious ActiveX on the Kiosk?Can we install a malicious ActiveX on the Kiosk?

iKAT ActiveX

Safe-for-scripting ActiveX which executes arbitrary executables.

Installing an ActiveX requires administrative authority.g q y

ActiveX is changing:ActiveX is changing:

Internet Explorer 8 does not require admin rights for ActiveX.



Hacking Kiosk Softwareg

iKAT & ClickOnce Applications

ClickOnce is NET 2 0+ technology ( NET CLR 2+ required)ClickOnce is .NET 2.0+ technology (.NET CLR 2+ required)

‘Online Application Deployment’ .application file handler.

Unsigned ClickOnce applications execute with full trust!Unsigned ClickOnce applications execute with full trust!

Admin privileges are not required!

Users are warned:

100% of tested Kiosks fail to detect this warning message

Modern Kiosks now developed in .NET (CLR is present!)



Hacking Kiosk Softwareg

“What are the most useful ClickOnce applications to have?”

iKAT - Embedded Web Browser.

HTTP browser with reduced security settings.

iKAT - Application Executor.

Spawn’s any arbitrary executables on a KioskSpawn s any arbitrary executables on a Kiosk.

iKAT - Access Token Pincher

Access token hijacking is very hip subject, why not.

Does the Kiosk user have the SeImpersonate privilege?

Impersonate available (privileged) tokens.

Spawn cmd.exe under the context of the privileged token.Spa c d e e u de t e co te t o t e p eged to e

Pop a system shell!



Hacking Kiosk Softwareg

Who Here Has Ever Crashed a Web Browser?

What about crashing a Kiosk: ‘Emo-Kiosking’What about crashing a Kiosk: Emo-Kiosking

Create an unhandled exception in a Kiosk browser.

Kiosk browser crashes We get the desktop We Win!Kiosk browser crashes, We get the desktop, We Win!

Rare situation: Application crash = highly critical vulnerability.

iKAT Contains Common Browser Crash Techniques.

P bli h d l it hi h lt i hPublished exploits which results in a crash.

Fastest, easiest method of escaping a Kiosk.

Fairly reliable, 40% of tested Kiosks crash.



Hacking Kiosk Softwareg

Crashing Browser Plug-ins.

Flash is the most common browser plug-in availableFlash is the most common browser plug-in available.

“Can I create a .SWF file that reliably crashes a browser?”

Turns out yes yes you can!Turns out yes, yes, you can!

File format fuzzing of .SWF found multiple crash situations.

d l l bl l bl h bImmediately un-exploitable, reliably crash any browser. 

Created ‘iKAT Auto Magic Flash Crasher’.

Is the Flash plug-in installed on the Kiosk?

iKAT can crash it, guaranteed.iKAT can crash it, guaranteed.

Does the Kiosk detect the unhandled exception and re-spawn?

Or just present the desktop?Or just present the desktop?



Downloading Toolsg

Lets Assume Something Worked.

You have access to the Kiosk File systemYou have access to the Kiosk File system. 

Command shell spawned, Common Dialog,  Java installed, etc

What Now?

Download additional tools/binariesDownload additional tools/binaries.

How Do You Download Files In a Tool-less Environment.

Kiosk terminal will not have a copy of wget.exe present.

Internet Explorer is likely uninstalled or disabled.

File downloads disabled.



Downloading Toolsg

Old School: Downloading Files In Windows:

Using Common DialogsUsing Common Dialogs

‘Attach’ a remote file from a File-Open dialog.

FPSE/WebDAV to save the file locally and attach itFPSE/WebDAV to save the file locally, and attach it.

k l lWorks From Any File->Open Dialog.

File saved in a writeable location.

Temporary internet files.

Downloads any file type/size.



Downloading Toolsg

Use Flash To Download Files.

Kiosk’s disable File Downloads within the browser security policyKiosk s disable File Downloads within the browser security policy.

IE: Tools -> Internet Options -> Custom Level

Flash can be used to circumvent the browser policy.

Download method of FileReference() object.Download method of FileReference() object.

Flash does not validate browser security policy.

Very high success rate against Kiosks.

Because its an 0day trick.



Downloading Toolsg

Notepad Can Download Files.

File > OpenFile-> Open

http://test.com/trojan.txt

Fil d l d dFile downloaded.

Cannot save 8bit data.

Content must be 7bit safe.

File-> SaveFile > Save

Upload content to a remote site.

FPSE/WebDavFPSE/WebDav

http://www.ok.com/blah.txt

Quickly upload files from a KioskQuickly upload files from a Kiosk.



Downloading Toolsg

#1 Problem: Kiosk Hacking is a Tool less Environment

“iKAT needs to provide tools for Kiosk hacking”iKAT needs to provide tools for Kiosk hacking .

Assorted Kiosk Hacking Tools

All tools available in .exe, .zip, Flash security policy bypass.

Also Available as 7bit Safe VBScript (.VBS/.VBE)!

Download and save the tool using notepad.



Downloading Toolsg

Command Shell Detours:

How many ways to spawn a command shell on Windows?How many ways to spawn a command shell on Windows?
cmd.exe command.com win.com cmd.exe win.com command.com

Loadfix.com start.exe sc create testsvc binpath= 
"cmd /K start" type= own

loadfix.com cmd.exe loadfix.com command.com
cmd /K start  type  own 

type= interact

start loadfix.com cmd.exe start loadfix.com
command.com

start loadfix.com
cmd.exe

%COMSPEC%

Win.com? Loadfix.com? Start? Combinations of both?

ACL’s on the Kiosk may block cmd.exe

What about command.com, win.com?

‘CMD Detours’ tool attempts 17 methods of invoking a shell.

Flawless at bypassing Kiosk ACL’sFlawless at bypassing Kiosk ACL s.



About iKAT

Using iKAT

iKAT is a tool designed to aid penetration testing/Kiosk hacking.

Use it to configure your own Kiosk securely!

Test the strength of your own blacklists

Blacklist Window dialogs, increase your level of security.

Feedback Welcomed!

Submit a feature request report a bug help me improve iKATSubmit a feature request, report a bug, help me improve iKAT.

iKAT is going Open Source!

iKAT Portable being released soon

Downloadable version you can host locally, memory stick.y y, y

Useful for security consultants without internet access.



Pwnage!g

Hacking Kiosks : The Demo’sg

Two virtualized (commercial) Kiosk products.

Recommended Kiosk application configuration.Recommended Kiosk application configuration.

Default Windows XP install.

Using iKAT To Pop a Command shell

A F t A P ibl !As Fast As Possible!



Conclusion

Happy Hacking.

Questions?

Email me:

paul.craig@security-assessment.com


